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map (number to convert, current maximum value, current maximum value, current maximum 

value to be converted, maximum value to be converted)  

A function that simply represents the value that is converted using a proportional expression. 

The value being converted is expressed as an integer (including negative numbers),  

and the decimal number is not rounded up. 
 

 
 
Converts the number of 0 to 1023 accepted by portVal to a value between 0 and 255. 

 View Results 

After uploading the sketch, pushing the slider of variable resistance left and right changes the analog 

input value. As the resistance value increases, you can see that the color of the RGB LED changes to 

red - > green-> blue..  

 

 

 

int ledLevel= map(potVal,0,1023,0,255);

Figure 54 
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8. Melody with a Passive Buzzer

 
Figure 55 
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 Play the melody using the tone( ) function on the manual buzzer connected to digital pin 6..  

 Passive Buzzer 

Piezo buzzer is a small speaker that makes sound using piezo effect that creates vibrations when 

electricity is released. The downside is that the sound isn't loud, but you can also play 

music if you manipulate it carefully. The piezo buzzer is polar and should be connected 

to the (+) pole by the side that reads (+) on the top or has a small groove dug.  

The piezo buzzer is largely divided into active buzzer and passive buzzer. The active 

buzzer has built-in circuits, so it is often used to alert people as it makes only one 

sound of a certain frequency when current flows. A manual buzzer is a buzzer that 

makes sound through a tone function that can produce frequencies between 31 and 

65535 Hz.  

 

 
 The best way to distinguish between these two 

buzzers is to connect the two pins of the buzzer to 

the GND and 5V of the Arduino board to the 

active buzzer if a constant sound occurs and the 

manual buzzer if there is no sound. The coding 

array kit uses a manual buzzer module for digital 

No. 6 pin, so you can play melodies..  
 

To perform melodies with a manual buzzer, use the tone (pin number, negative frequency, negative duration) 

function, which uses integer values as follows:. . 

Frequency by octave and pitches (in Hz) 

octave 
pitches 

1 2 3 4 5 6 7 8 

C (do) 33 65 131 262 523 1047 2093 4186 

C# 35 69 139 277 554 1109 2217 4335 

D (re) 37 73 147 294 587 1175 2349 4699 

D# 39 78 156 311 622 1245 2489 4987 

E (mi) 41 82 165 330 659 1319 2637 5274 

F (fa) 44 87 175 349 698 1397 2794 5588 

F# 46 93 185 370 740 1480 2960 5920 

G (sol) 49 98 196 392 784 1568 3136 6272 

G# 52 104 208 415 831 1661 3322 6645 

A (La) 55 110 220 440 880 1760 3520 7040 

A# 58 117 233 466 932 1865 3729 7459 

B (Si) 62 123 247 494 988 1976 3951 7902 

Figure 56 

Figure 57
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Table 11 

Let's find out how to give a constant name to a frequency value 

with #define..  

 

Each sound meter has its own frequency of shaking and should be predefined so that the frequency (in units 

Herz HZ) value of the sound meter. Write the frequency required to play the melody by defining it as the 

#define constant name value (e.g. #define NOTE_C1 33) before { }. #define is a function that gives a name to 

a constant value before a program compilation. Be careful not to put "=" between the constant and the 

value, and not to use the semicolon at the end..  

 

#define NOTE_B0  31 

#define NOTE_C1  33 

#define NOTE_CS1 35 

: 

Let's learn how to save the pitches.h header file.. 

If you find it difficult to put a sound frequency value into a program each time, you can also create a 

separate library of files for the sound frequency value. Let's learn how to create and store a sound frequency 

file in a file called "pitches.h.".  

 

 Way 1. File > Preferences > Open the folder in the Sketchbook location..  

 

 Create pitches folder under libraries folder.  

Figure 58

Figure 59 
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When you open the file > Example > 02. Digital > ToneMelody in the pitches folder, copy the pitches.h on 

the right tab and save it as a file and make it a library. 

 

 

Figure 60 

 

You can also edit and use it as needed. Bring up header file to #include "pitches.h" before void setup { }.  
 

 

 

 

 

 

Way 2. New File > New Tab  
 Create a new tab by tapping the bottom of the serial 

monitor icon.. 

 

 

 

 
 

 Type pitches.h in the name for the new file and click OK..  

 

 

Figure 61

Figure 62 
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When you open File > Example > 02. Digital > ToneMelody, copy and paste the pitches.h on the right tab 

to save. The pitches.h header file is stored in the same folder as the program. This file can also be edited 

and used as needed. Stored header file is called #include "pitches. h" before void setup { }.  

Figure 63 



66 

 

CAK Starter Code > 08_PassiveBuzzer 

1 / *  This sketch plays a note through a buzzer connected to pin 6. 

2  *  The * tone() function calls up the pitches.h header file to give a given frequency sound. 

3  *  Play a familiar 'school bell' song to us. 

4  *  In this sketch, the code is inserted in the setup part and played only once. 

5  *  If the loop part is coded, the performance may be repeated. 

6  */ 

7   

8 #include "pitches.h" 

9  

10 int buzzer=6;            // Connect the Piezo buzzer to No. 6. 

11                          // the pitch of playing 

12 int melody[] ={NOTE_G7,NOTE_G7,NOTE_A7,NOTE_A7,NOTE_G7, 

13                 NOTE_G7,NOTE_E7,NOTE_G7,NOTE_G7,NOTE_E7, 

14                 NOTE_E7,NOTE_D7,0,NOTE_G7,NOTE_G7,NOTE_A7, 

15                 NOTE_A7,NOTE_G7,NOTE_G7,NOTE_E7,NOTE_G7, 

16                 NOTE_E7,NOTE_D7,NOTE_E7,NOTE_C7,0 

17                }; 

18                             // Sound length, 4 = crotchet, 2 = minim 

19 int noteDurations[] ={4,4,4,4,4,4,2,4,4,4,4,3,1,4,4,4,4,4,4,2,4,4,4,4,3,1}; 

20  

21 void setup() { 

22   for(int thisNote =0; thisNote <26; thisNote++) 

23   { 

24     int noteDuration =1000 /noteDurations[thisNote]; 

25     tone(buzzer, melody[thisNote], noteDuration);      // Connect the Piezo buzzer to No. 6 

26     int pauseBetweenNotes =noteDuration *1.30;          // phonetic delimiting 

27     delay(pauseBetweenNotes);                           //delay 

28     noTone(buzzer);                               // Stop playing music 

29   } 

30 } 

31  

32 void loop() { 

33 } 

tone (pin number, sound frequency, sound duration);  To make a sound of a 

specific frequency. 

Sound frequency: Hertz unit (Hz), rounded to the standard frequency to add an integer. 

Sound duration: Milliseconds, unsigned long type, and optionally.  

Only one note can be generated at a time.  

The tone( ) function prevents PWM output on pins 3 and 11.  
 

Figure 64 
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noTone (Pin Number);  Stop the waveform generated by tone( ).  

In order to play different scales on different pins, you must call noTone before calling the 

next pin. 

 

  View Results 

Once the sketch is uploaded, you can check out the 'school bell' song. If you want to repeat the 
performance, you can insert the code into the void loop. 
Caution: passive buzzer can't produce frequency specific sounds 
 

Let's find out about the layout.. 

The array allows you to declare as many variables as in [ ]. If the length of the array is omitted in [ ],  

the compiler will determine the length of the array by referring to the number of values in the list.  

You can also initialize the values with the array declaration at the same time.. 

int array name [collection length] 

The number of int variables is declared side by side.  

Array name[0]=value1; store value1 on first element of array 

Array name[1]value2; store value2 on second element of array 

 

A number in [ ] is called an index, and the index value begins at zero..  

int array name[ ] = {value1, value2, ... } 

If the length of the array is omitted in [ ], the compiler will refer to the number of values in the list.  

Figure 65 

Figure 66 
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Determine the length of the array. 

You can also initialize the values with the array declaration at the same time..  

 

Figure 79 

 

 

 

 

 

 

 

  

Figure 80 
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9. Texting on 1602 I2C LCD 

 

Figure 67 
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 Print out characters using the I2C interface module, which controls 1602 LCDs consisting of 2 rows wide 

and 16 spaces with SDA (Serial Data, A4) and SCL (Serial Clock, A5), as well as GND, and 5 volt total..  

 LCD (Liquid Crystal Display) 

LCD is a liquid crystal display device that is often used for wrist watches and calculator screens. Thin and 

light, low power consumption makes it good for portable devices. However, background lighting (backlight) 

is necessary for clear display, and the viewing angle is narrow, and Han-gul or special characters have the 

disadvantages of not being well expressed. 

The 1602 LCD used in the starter kit is a liquid crystal display unit that outputs 16 characters (a total of 32 

characters) on each of the two lines across which it is used to output messages or sensor data. The 1602 

LCD consists of 16 pins as shown below for connection.. 

 

Figure 68 

1 VSS GND connection
power

2 Vdd 5V connection

3 V0 the darkening of letters

Setting
4 RS Select space to store LCD values

5 RW Select a value for the LCD in read/write mode

6 E To write a value to the LCD

7 DB0

Data input/output pin

Used when LCD and Arduino exchange prices.
data

8 DB1

9 DB2

10 DB3

11 DB4

12 DB5

13 DB6

14 DB7

15 A 5V connection Background brightness control. No pins when 

no background lights or no background 

brightness is required16 K GND connection
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Table 12 

 Inter-Integrated Circuit Interface 

The basic wiring for using a 1692 LCD uses a lot of digital pins, as shown in Figure below..  

 

Figure 69 

But Arduino Uno has 14 digital input/output pins and six analog input pins. If you want to connect other 

parts to Uno with 1602 LCD, there may not be enough connecting ports because it requires a lot of pin 

connections.  

To address these issues, the coding array starter 

kit uses the I2C interface module. The I2C 

interface module has variable resistance that 

adjusts the clarity of the writing, so it does not 

have to be connected to variable resistance.. 

 

 

Figure 71 

The I2C interface module and 1602 LCD module are connected as shown in Figure above, and the LCD can 

be removed and used as a normal 1602 LCD..  

Figure 70
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 I2C (Inter-Integrated Circuit) is an NFC that can connect a 1 master 

(Arduino) : multiple slave (sensor modules) in one direction using a SCL (Serial 

Clock) pin and SDA (Serial Data) pin with full-up resistance connected. Arduino 

can use SDA, SCL pins as I2C communication pins or analog A4, A5 pins as 

functions of SDA and SCL respectively. In the starter kit, the SDA and SCL pins 

of the Uno board were placed for easy selection with the slide switch in the 

center of the Arduino Uno board. 

 

CAUTION! You cannot use the I2C communication interface and the A4, A5 pins at the same time on the 

Arduino board. Therefore, the thermistor module and flame sensor module cannot be used simultaneously 

with the I2C LCD in the starter kit. Therefore, when using I2C LCD, define the module of use by placing 

the slide switch left and right as shown in Figure below..  

 
Figure 73 

For I2C communication, the Wire library must be added. To add a library, click Sketch > Include Library > 

Manage Libraries to run the Library Manager. Search for "I2C LCD" in the search box and install 

"LiquidCrystal I2C by Frank de Brabander." 

Figure 74 

The default address is 0×27 (hexadecimal value), but sometimes an error occurs when using a 

module, the address must be checked. Address scanning is recommended first to find the address 

of the I2C LCD interface module you want to use. 

Figure 72 
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CAK Starter Code > 09_01_1602LCD_AddressScanning 

1 /* This sketch is designed to use 1602 LCDs using I2C communication. 

2  * Scans the address to show the results on the serial monitor. 

3  */ 

4   

5 #include <Wire.h>            // Includes the Wire Library for I2C communication. 

6  

7 void setup() { 

8   Wire.begin(); 

9   Serial.begin(9600);              // Starts serial communication at 9600 speeds 

10   while(!Serial);                  // Wait for the serial monitor. 

11   Serial.println("\nI2C Scanner"); 

12 } 

13  

14 void loop() { 

15   byte error,address; 

16   int nDevices; 

17   Serial.println("Scanning..."); 

18   nDevices =0; 

19  

20   for (address =1; address <127; address++)  { 

21     // The i2c_scanner has determined whether the device has approved the address. 

22     // Use the Write.endTransmission return value to know.  

23     Wire.beginTransmission(address); 

24     error =Wire.endTransmission(); 

25  

26     if (error ==0) { 

27       Serial.print("I2C device found at address 0x"); 

28       if(address<16)  

29         Serial.print("0"); 

30       Serial.print(address,HEX); 

31       Serial.println("  !"); 

32       nDevices++; 

33     } 

34     else if(error==4) {  

35       Serial.print("Unknown error at address 0x"); 

36       if (address<16)  

37         Serial.print("0"); 

38       Serial.println(address,HEX); 

39     }     

40   } 

41   if (nDevices ==0) 

42     Serial.println("No I2C devices found\n"); 

43   else 

44     Serial.println("done\n"); 

45  
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46   delay(5000);           // Wait five seconds for the next scan.. 

47 } 

Let's learn about the method used by LiquidCrystal_I2C.h.. 

LiquidCrystal_I2C lcd (0x27,16,2); The method under I2C 

communication address, 16-cand 2-line lcd object creation is for example if the object was named lcd.  

lcd.init(); Initialize LCD. 

lcd.backlight();  Turn on the LCD backlight. 

lcd.noBacklight();  Turn off the LCD backlight. 

lcd.setCursor(Rows); Sets the position of the cursor. 

lcd.print(data, BASE); 

Print the text on the LCD screen. 

Data : Data to be printed, char, byte, int, long, stringable.  

Characteristic data is displayed in "In" 

BASE (Optional) : The standard by which a number is printed.  

BIN (binary), DEC (decimal), OCT (8 decimal), HEX (16 

decimal) 

lcd.scrollDisplayLeft(); Scroll text and cursors one space to the left 

lcd.scrollDisplayRight(); Scroll text and cursors one space to the right 

lcd.noDisplay();  

urn off the screen. The string on the face disappears, but the contents 

remain in internal memory. lcd.display(); when a function is called, the 

string is revived. 

lcd.display();  
Turn on the screen. lcd.noDisplay(); and lcd.display(); two functions can 

have a flicker effect on the entire screen. 

lcd.autoscroll(); Scroll text and cursors one space to the left 

lcd.noAutoscroll();  Scroll text and cursors one space to the right 

lcd.clear();  Clear the LCD screen and place the cursor in the upper left corner. 

lcd.cursor();  
Indicates the underscore of the position in which the following 

characters are written 

lcd.noCursor();  Hide the LCD cursor. 

lcd.rightToLeft();  
Set the direction of the string used for the LCD from right to left. The 

default value is left to right. It does not affect previously printed text. 

lcd.leftToRight();  
Set left to right direction of string written to LCD. It does not affect 

previously printed text. 

lcd.write( );  Text is written on the LCD. 
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lcd.createChar(number,data); 

Create a custom character to use for LCD. Up to 8 characters 5*8 pixels 

are supported. 

Numeric : Numbers from 0 to 7. Specify the number of characters to 

create. 

Data: Pixel Data for Text 

lcd.noBlink();  Turn off the blinking LCD cursor. 

lcd.blink(); Turn on the blinking LCD cursor. 

lcd.home();  
Position the cursor in the upper left corner of the LCD and output the 

string. 

Table 13 

Learn how to print characters on an LCD using method and how it works.. 

CAK Starter Code > 09_02_1602LCD_HelloCAK 

1  /*  This sketch shows Hello! ^ _ ^ ! Coding Array Kit for 1602 LCDs using I2C communication 

2  *  Show the string, using scrollDisplayRight and scrollDisplayLeft methods 

3  *  Scrolls to the left and right. 

4  *  Flashes the screen using noDisplay and discaly method to indicate that one loop is complete. 

5  */ 

6   

7 #include <Wire.h>  

8 #include <LiquidCrystal_I2C.h> 

9  

10 LiquidCrystal_I2C lcd(0x27,16,2);  // Set the LCD I2C address. Use 16-kan2 line LCD. 

11                                     // Put the scanned address instead of 0x27. 

12 void setup(){ 

13   lcd.init(); 

14   lcd.backlight();                // Turn on the backlight. (lcd.noBacklight() turns off the backlight.) 

15   lcd.setCursor(0,0);                 // first line first column 

16   lcd.print("Hello ! ^ _^ !"); 

17   lcd.setCursor(0,1);                // 2nd line first column 

18   lcd.print("Coding Array Kit"); 

19   delay(1000); 

20 } 

21  

22 void loop(){ 

23   // Scroll 16 length of string to the left               

24   for(int positionCounter = 0; positionCounter < 16; positionCounter++) { 

25     lcd.scrollDisplayLeft();                           // Scroll to the left by one position 

26     delay(200);                                        // for 200 milliseconds 

27   } 

28  

29   // String length 16+ Rows 16 Scroll to the right at a total of 32 locations 

30   for(int positionCounter = 0; positionCounter < 32; positionCounter++) { 
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31     lcd.scrollDisplayRight();                          // Scroll to the left by one position 

32     delay(200);                                       // for 200 milliseconds 

33   } 

34  

35   // Scroll to the left 16 positions to center 

36   for(int positionCounter = 0; positionCounter < 16; positionCounter++) { 

37     lcd.scrollDisplayLeft();                          // Scroll to the left by one position 

38     // wait a bit: 

39     delay(200);                                       // for 200 milliseconds 

40   } 

41  

42   // noDisplay and dispaly 

43   lcd.noDisplay();   // Turn off the screen 

44   delay(500);       // for 0.5 second 

45   lcd.display();      // Turn on the screen 

46   delay(500);        // for 0.5 second 

47 } 

CAK Starter Code > 09_03_1602LCD_Autoscroll 

1  /*  This sketch shows that 1602 LCD uses I2C communication. 

2  *  Numbers from 0 to 9 are displayed on the screen. 

3  *  Use the autoscroll( ) and noAutoscroll( ) methods. 

4  *  Show how to move all strings left or right. 

5  */ 

6   

7 #include <Wire.h>  

8 #include <LiquidCrystal_I2C.h> 

9  

10 LiquidCrystal_I2C lcd(0x27,16,2);  // Set the LCD I2C address. Use 16 Space 2-line LCD. 

11  

12 void setup(){ 

13   lcd.init(); 

14   lcd.backlight();                // Turn on the backlight. (lcd.noBacklight() turns off the backlight.) 

15 } 

16  

17 void loop() { 

18   lcd.setCursor(0,0);                         // Position the cursor (0,0) in the upper left corner. 

19  

20   for(int thisChar = 0; thisChar <10; thisChar++) {      

21     lcd.print(thisChar);                      // The numbers from 0 to 9 are shown on the LCD. 

22     delay(500);                               // For 0.5 Second 

23   } 

24  

25   lcd.setCursor(16,1);                       // Position the cursor in the lower right hand corner. 
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26   lcd.autoscroll();                          // Set to auto-scroll 

27    

28   for(int thisChar = 0; thisChar <10; thisChar++) { 

29     lcd.print(thisChar);                     // The numbers from 0 to 9 are shown on the LCD.. 

30     delay(500);                              // For 0.5 Second 

31   } 

32  

33   lcd.noAutoscroll();                        // Automatic Scroll Revocation 

34   lcd.clear();                                // Clear the screen before going to the next loop. 

35 } 
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CAK Starter Code > 09_04_1602LCD_TextDirection 

1 /*  This sketch shows that 1602 LCD uses I2C communication. 

2  *  Show one alphabet from a to Z. 

3  * 'a through l' is written from left to right. 

4  *  'm through r' is written from right to left 

5  *  's through z' causes text to appear from left to right again. 

6  */ 

7   

8 #include <Wire.h>  

9 #include <LiquidCrystal_I2C.h> 

10  

11 LiquidCrystal_I2C lcd(0x27,16,2);  // Set the LCD I2C address. Use 16 Space 2-line LCD. 

12                                      

13 int thisChar ='a';                                     // thisChar Save                                  

14  

15 void setup(){ 

16   lcd.init(); 

17   lcd.backlight();                // Turn on the backlight. (lcd.noBacklight() turns off the backlight.) 

18   lcd.cursor();                  // Turn on the cursor. 

19 } 

20  

21 void loop(){ 

22   if(thisChar =='m') {                   // If thisChar is m, change direction. 

23     lcd.rightToLeft();                           // From the next letter, mark to the left. 

24   } 

25  

26   if(thisChar =='s') {                  // If thisChar is s 

27     lcd.leftToRight();                          // From the next letter, mark to the left. 

28   } 

29  

30   if(thisChar >'z') {                    // When thisChar is out of z, 

31     lcd.home();                                 // Go to (0,0) 

32     thisChar ='a';                              // Restart from the beginning 

33   } 

34  

35   lcd.write(thisChar);                 // Indicate thisChar value on LCD. 

36   delay(1000);                         // for a second 

37   thisChar++;                          // increase thisChar value one by one 

38 } 
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CAK Starter Code > 09_05_1602LCD_CustomCharacters 

1  /*  This sketch shows that 1602 LCD uses I2C communication. 

2  *  Set up a special character or Figure to "I  Array Kit !" and smile on the first line of the LCD. 

3  *  In the second row, the shape of a person who raises and lowers his or her arms is displayed. 

4  *  Learn how to indicate that the value of A0 variable resistance is constant. 

5  */ 

6   

7 #include <Wire.h>  

8 #include <LiquidCrystal_I2C.h> 

9  

10 LiquidCrystal_I2C lcd(0x27,16,2);  // Set the LCD I2C address. Use 16 Space 2-line LCD. 

11  

12 // Create special characters 

13 byte heart[8] ={ 

14   0b00000, 

15   0b01010, 

16   0b11111, 

17   0b11111, 

18   0b11111, 

19   0b01110, 

20   0b00100, 

21   0b00000 

22 }; 

23  

24 byte smiley[8] ={ 

25   0b00000, 

26   0b00000, 

27   0b01010, 

28   0b00000, 

29   0b00000, 

30   0b10001, 

31   0b01110, 

32   0b00000 

33 }; 

34  

35 byte frownie[8] ={ 

36   0b00000, 

37   0b00000, 

38   0b01010, 

39   0b00000, 

40   0b00000, 

41   0b00000, 

42   0b01110, 

43   0b10001 

44 }; 

45  

46 byte armsDown[8] ={ 

47   0b00100, 
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48   0b01010, 

49   0b00100, 

50   0b00100, 

51   0b01110, 

52   0b10101, 

53   0b00100, 

54   0b01010 

55 }; 

56  

57 byte armsUp[8] ={ 

58   0b00100, 

59   0b01010, 

60   0b00100, 

61   0b10101, 

62   0b01110, 

63   0b00100, 

64   0b00100, 

65   0b01010 

66 }; 

67                                      

68 void setup(){ 

69   lcd.init(); 

70   lcd.backlight();                // Turn on the backlight. (lcd.noBacklight() turns off the backlight.) 

71    

72   // Define New Characters 

73   lcd.createChar(0,heart);                    

74   lcd.createChar(1,smiley);  

75   lcd.createChar(2,frownie); 

76   lcd.createChar(3,armsDown); 

77   lcd.createChar(4,armsUp); 

78  

79   lcd.setCursor(0,0);                 // first line first column 

80   // Write text to LCD 

81   lcd.print("I "); 

82   lcd.write(byte(0));                           // Use a heart that is stored at 0 bytes.. 

83   lcd.print(" Array Kit! "); 

84   lcd.write((byte)1);                           // Use a smiley stored in one byte.. 

85 } 

86  

87 void loop(){ 

88   int sensorReading = analogRead(A0);       // Read the variable resistance value of A0. 

89   int delayTime = map(sensorReading,0,1023,200,1000);  // Map resistance values from 200 to 1000 

90   lcd.setCursor(4,1);                       // Set the cursor to the bottom 5th position 

91   lcd.write(3);                             // Draw a person with his arm down on number 3. 

92   delay(delayTime);                         // Delay by variable resistance value 

93   lcd.setCursor(4,1);                       // Set the cursor to the bottom 5th position 

94   lcd.write(4);                             // Draw the person with the arm up stored in number 4. 

95   delay(delayTime);                         // Delay by variable resistance value 

96 } 



81 

 

byte Save the 8-bit signless number from 0 to 255. 

 

The shape of each user-defined character consists of 5×8 dots. Each row is specified in an array of 

eight bytes, one by one, and each row is defined as a hexadecimal. Assuming that you make a 

heart, you can set it as follows: 

 

Figure 75 

Special characters specified in the array are defined as lcd.createChar (number, data). The numbers 

can then be defined by a total of eight characters from 0 to 7, and the data can be named after 

the array.  lcd to output user-defined characters to LCD.use a number. 

 View Results 

 

Figure 76 

 

Figure 77 
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You can adjust the rate of special character change in the second row by adjusting the variable 

resistance of the slide..  

CAK Starter Code > 09_06_I2C_1602LCD_SerialDisplay 

1 /*  This sketch shows that 1602 LCD uses I2C communication. 

2     Try printing the entered characters in the serial window. 

3 */ 

4  

5 #include <Wire.h> 

6 #include <LiquidCrystal_I2C.h> 

7  

8 LiquidCrystal_I2C lcd(0x27, 16, 2); // Set the LCD I2C address. Use 16 Space 2-line LCD. 

9  

10 void setup() { 

11   lcd.init(); 

12   lcd.backlight();                // Turn on the backlight. (lcd.noBacklight() turns off the backlight.) 

13  

14   Serial.begin(9600);                        // Starts serial communication at 9600 speed 

15 } 

16  

17 void loop() { 

18   if (Serial.available()) {   // When the text arrives on the serial communication, 

19     delay(100);                // Wait 0.1 seconds for the entire message to arrive. 

20     lcd.clear();               // Clear the screen. 

21     while (Serial.available() > 0) { // while the text is coming in 

22       lcd.write(Serial.read());        // Write the characters you read on the LCD. 

23     } 

24   } 

25 } 

 

Serial.available(); returns the number of data when received by serial communication.  

Returns zero if no data has been received.  

Serial.read(); to read data entering the serial by 1 byte and return it to the decimal (constant)   

ASCII code value. Returns –1 if the receive buffer is empty.  

lcd.write(Serial.read()); data entered into the serial are passed in aske code numbers.  

It is represented by converting it to a letter using lcd.write.  

If you write lcd.print, the number of Aski codes will be output.    
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 View Results 

 

Figure 78 

 

Figure 79 

 

When you enter and transfer data in the serial window, the data is output on the first line of the LCD.  

If you enter more than 16 data, only 16 will appear in the first line..  

 

Let's find out about While Sentence. 

 

while {execution code; } 

 'While' is one of the repeats used to give the same command over 

and over, like 'for'. 'While statement' is a structure that gives a certain 

repeat condition and repeats the execution code while satisfying the 

condition. For statement lists the multiplication table under the 

iterative conditions, but in the whle statement, the multiplication 

ceremony is placed in the execution code.. 

 Figure 80
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10. Distance measurement with ultrasonic sensor 

 

Figure 81 
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 The trigger that produces ultrasonic waves is connected to digital No. 5 and the echo that detects 

reflected ultrasonic waves is connected to digital No. 4. Using the principles of ultrasonic sensors, measure 

the distance to the obstacle in front..  

 

 Ultrasonic Distance Module 

  

Ultrasonic is a type of sound wave, which is the sound wave of a 

frequency (&gt;20KHz) area that is higher than the area that a person 

can hear. Ultrasonic sensors can calculate the distance using the time it 

takes for sound waves to return to an obstacle that is close to 3-400 cm..  

 

Ultrasonic sensors have two speakers that 

look like speakers. One side has to produce ultrasonic waves with digital output 

HIGH and then stops ultrasonic waves with LOW. Ultrasonic sensors used in the 

rasonic waves reflected on an object. 

To detect the return of ultrasound, make sure that the reflector and the ultrasonic sensor are at right angles.. 

 

Distance, velocity and time form the following formular 

velocity =  
Distance

time
             ,     time =  

Distance

velocity
    ,      Distance = velocity × time 

 

 

Ultrasonic waves can be generated from the trig pin of the ultrasonic sensor and obtained by means of the 

reciprocating distance, reciprocating time and sound velocity reflected on the barrier..  

  =    ×      

 

       =  
 ×         

2
 

 

Figure 83

Figure 84 

Figure 82 
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In Arduino, the time it takes for the ultrasound to return is in microseconds (), so the distance can be 

obtained in cm after the unit conversion.. 

 

   =  
  ×          ( )

2

=  
1

2
×

340 

1 
×

100 

1 
×           ×

1 

1000000 
= 0.017 ×         ( ) 

 

At this point, the speed of sound is about 340 m/s at 15°C, and as the temperature rises by 1°C, the speed 

of 0.6 m/s increases. Therefore, it may be used with the following corrections:. 

 

Sound speed = 340 + 0.6 × (current temperature 15) 

 

Using the principles of ultrasonic sensors, one can measure a key or 

measure a distance to an obstacle in front of one. It is also possible 

to implement a parking system by sensing that the parking space is 

empty or parked, such as a parking lot in a large shopping mall.  

Ultrasonic waves are also used to examine the condition of the 

human organs or to identify deep undersea terrain, as the density of the medium that transmits sound is 

higher. In vacuum, there is no medium, so distance measurements using ultrasonic waves are not allowed..  

  

Figure 85 
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CAK Starter Code > 10_Ultrasonic_Distance 

1 / *  This sketch uses ultrasonic sensors to measure the distance. 

2  *  The trigger pin is connected to Arduino's number 5. The trigger pin produces ultrasonic waves. 

3  *  Echo pins are connected to Arduino's number 4. The echo pin detects reflected ultrasound. 

4  *  The measured distance should be shown in both the serial and LCD windows. 

5  *  If the measured distance exceeds the set value, the green LED, 

6  *  If the measured distance exceeds the set value, turn on the red LED. 

7  */ 

8   

9 #include <Wire.h>  

10 #include <LiquidCrystal_I2C.h> 

11  

12 LiquidCrystal_I2C lcd(0x27,16,2);  // Set the LCD I2C address. Use 16 Space 2-line LCD 

13  

14 int redLED = 13;                 // Red LED No. 13 

15 int greenPin=10;                 // Green LED No. 13 

16 int threshold = 15;              // Set Distance Threshold Value 

17  

18 void setup() { 

19  pinMode(5,OUTPUT);     // Trigger pin connection No. 5 

20  pinMode(4,INPUT);      // Echopin to Pin 4 

21  

22   pinMode(redLED,OUTPUT);      // Set pin 13 to output 

23   pinMode(greenPin, OUTPUT);   // Set pin 10 to output 

24  

25   Serial.begin(9600);            // Starts serial communication at 9600 speeds 

26       

27   // LCD Setting 

28   lcd.init(); 

29   lcd.backlight();                // Turn on the backlight. (lcd.noBacklight() turns off the backlight.) 

30   lcd.clear(); 

31 } 

32  

33 void loop() { 

34 //  Distance measurement with ultrasonic sensor 

35   float Duration, Distance; 

36   digitalWrite(5, HIGH);                                     // Fire an ultrasound. 

37   delayMicroseconds(10);                                  // for 10 microseconds 

38   digitalWrite(5, LOW);                                      // Turn off the ultrasound. 

39   Duration =pulseIn(4, HIGH);                                // Save the time the ehofin is held in HIGH 

40   Distance =((float)(340 *Duration) /10000) /2;              // convert the distance to cm 

41  

42 // Measured Distance Output 

43   Serial.print(Distance);                     // Print distance in serial window without changing lines 

44   Serial.println("cm ");                       // unit output 

45  

46   if (Distance < threshold){           // If the measurement distance is less than the threshold value, turn on the 
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red LED. 

47      digitalWrite(redLED,HIGH); 

48      digitalWrite(greenPin,LOW);      

49      // Show Distance to LCD Window 

50     lcd.clear(); 

51     lcd.setCursor(0,0);                 // first line first column 

52     lcd.print(Distance);                // Measured Distance Output 

53     lcd.print("[cm]");   // unit output 

54   } 

55   else {                           // If the measured value is greater than the threshold value, turn on the green LED. 

56      digitalWrite(redLED,LOW); 

57      digitalWrite(greenPin,HIGH);      

58      // Show Distance to LCD Window 

59     lcd.clear(); 

60     lcd.setCursor(0,0);                 // first line first column 

61     lcd.print(Distance);                // Measured Distance Output 

62     lcd.print("[cm]");   // unit output 

63   } 

64   delay(2000);                      // 2000 millisecond delay to reliably read values 

65 } 

 

float Duration, Distance; A variable with the same type of data can be declared at once..  

pulseIn(Pin number, Value, timeout); Measure the amount of time it takes to return after a pulse 

occurs. 

Pin number : pin number to read the pulse  

Value : Type of pulse to read. HIGH or LOW 

timeout (optional) : The time (microseconds) to wait for the pulse to start, and the length of the 

pulse (unshinged long) in microseconds.  

Returns zero if the pulse does not start within the specified timeout.  

It can operate from 10 microseconds to 3 minutes.  

pulseIn (echoPin, HIGH); when the value of echoPin reaches HIGH, start the timer and return the 

time that HIGH is maintained. 

 

((float)(340 *Duration) /10000) /2; Since the calculation result is a true type with a decimal point, 

attach the data type as float. 
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 View Results 

 

Figure 86 

 

Figure 87 

 

Once the program is uploaded, you can see that the green LED illuminates when the obstacle is more than 

15cm apart in front of the ultrasonic sensor, and that the red LED turns on when the obstacle is less than 

15cm away. 

  



90 

 

11. Detecting Magnetics with a Hall Sensor 

 

Figure 88 
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Analog magnetic sensing sensor module is connected to A2 pin.  You can check the analog output value that changes as 

the N pole and S pole of the magnet approach the sensor. It also looks at moving serial output data to Excel. 

 

 Magnetic Sensing Hall Sensor (Hall Effect Module) 

 

 Magnetic sensing hole sensor is a device that changes internal resistance according 

to strength of external magnetic field by using Hall Effect principle. The closer and 

stronger the magnetic field, the higher the output voltage. There are two types of Hall 

sensors: Digital Hall sensors and Analog Hall sensors. 

 

Hall Effect (Hall Effect) A conductor is placed in a magnetic 

field, and the flow of current in a direction perpendicular to 

both the magnetic field and the electric current in the 

conductor creates electromotive force in that direction, which 

is published by the potential difference in this direction, was 

discovered by the American physicist Hall (E. H. Hall). 

 

Digital hall sensors can only detect whether or not a magnetic field exists, and 

analog hall sensors can detect the magnetic field poles as well as the strength 

of the magnetic field with linear hall effects. Analog hall sensor module is used 

in array kit. As the S-pole approaches the front of the hall sensor, the voltage 

becomes close to 5 V, and the N-pole can be closer to the lock0 V, indicating the strength 

and poles of the upcoming magnetic field.. 

The magnetic sensing sensor can be used to check the magnetic field of the conductor to act as a switch or 

to detect the rotational speed, position and current of the motor. It is used variously in real life such as the 

speed measured on a car's instrument panel, the speed measured on a treadmill, and the door switch on a 

washing machine or refrigerator.  

Figure 90 

Figure 89 

Figure 91
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CAK Starter Code > 11_HallEffect 

1  /*  This sketch uses the Hall Effect module connected to Analog A2. 

2  *  Read the value of the analogue sensor which varies with the surrounding magnetic field 

3  *  Measure the strength of the magnetic field by converting it to voltage. 

4 
 *  This module has a lower output voltage as the N pole approaches and a higher output voltage as the S pole 

approaches. 

5  *  Outputs a comma-separated serial message for easy transfer of result values to Excel. 

6  *  Copy the message from the serial window and paste it into the memo pad.Save as CSV" extension 

7  *  You can create a file that can be retrieved from Excel. 

8 */ 

9  

10 // set up for LCD use 

11 #include <Wire.h> 

12 #include <LiquidCrystal_I2C.h> 

13 LiquidCrystal_I2C lcd(0x27, 16, 2); // Set the LCD I2C address. Use 16 Space 2-line LCD 

14  

15 const int hallPin = A2; //connect hall sensor to A2 pin 

16 int sensorReading;                        // Store analog sensor values 

17 int voltage;                            // Store the converted value to voltage 

18  

19 void setup() { 

20   Serial.begin(9600);     // Set communication speed to 9600 

21   Serial.println("sensorReading, Voltage (mv)");      // Output message for csv file in serial window 

22  

23   // LCD initialization 

24   lcd.init(); 

25   lcd.backlight();                // Turn on the backlight. (lcd.noBacklight() turns off the backlight.) 

26   delay(1000); 

27 } 

28  

29 void loop() { 

30   sensorReading = analogRead(hallPin);         // Read and save the analog value of the sensor 

31   voltage = sensorReading * (5.0 / 1024.0) * 1000; // Convert Analog Values from Voltage0 to 5000 

32  

33   // csv (when you want to receive data in comma-separated text format) 

34   Serial.print(sensorReading); 

35   Serial.print(","); 

36   Serial.println(voltage); 

37  

38   // Output a message in an LCD window 

39     lcd.clear(); 

40     lcd.setCursor(0, 0);                // first line first column 

41     lcd.print("Anlaog_V :"); 

42     lcd.print(sensorReading); 

43     lcd.setCursor(0, 1);                // 2nd line first column 

44     lcd.print(voltage); 

45     lcd.print(" mV"); 
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46   delay(500); 

47 } 

 View Results 

 

Figure 92 
 

 After the program uploads, the LCD screen outputs analog 

input values (approximately 506) and conversion voltages 

(approximately 2470 mV) when no magnetic field is detected. The 

closer the N pole of the magnet is to the magnetic sensing 

sensor, the smaller the analog input value, and the closer the S-

pole, the larger the analog input value..  

 

 

 In this example, let's move the data that appears in the serial 

window to Excel. Outputs data separated by commas, drags and 

copies the results shown in the serial window..   

 

 

 

 

Figure 93

Figure 94
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Attach this result value to Notepad and save it with a csv extension, such as file >Save 

As>result.csv. Open the csv extension file in Excel and use it.   

 

 

12.Learn how to use light sensing sensors to detect 

light intensity and calibrate sensor values. 

 

Figure 96 

  

Figure 95
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 Using a light sensing resistance sensor connected to the analogue A1 pin, control the LED output 

according to the intensity of the light, and learn about the calibration of the analog sensor values. 

 

  Photoresistor 

Light sensing resistance sensors are called by a variety of names such as 

light sensors, light sensing sensors, photoresistors, LDR (Light Dependent 

Resistors), Cadmium Sulfide (CdS), CdS Cells, CdS Photoresistors, 

Photometric Cells and Photocorel. As the intensity of light increases, the 

resistance value decreases, and the intensity of 

light can be measured by increasing the resistance value..  

The resistance values vary depending on the type of light sensor, but usually have 

relationship between resistance and intensity of light, as with the following Figure.  

Light sensors can measure the change in value due to the intensity of light at 

low prices, and have various advantages, such as night lighting or lighting sensing devices that control the 

speed of the camera shutter. However, resistance may vary with temperature, and there is a time difference 

between the change in intensity of light and the change in resistance.  It also has less light sensitivity than 

photo diode or photo transistor. Therefore, it is not suitable for use in places where rapid changes in light or 

intensity of light need to be accurately measured, and is suitable for determining only bright and dark levels.. 

 

As Arduino reads voltage values rather than resistance values, the resistance 

of the light sensor must be calculated using a voltage distribution scheme. In order to 

calculate the voltage entering the sensor using a voltage distribution scheme, the 

circuit should be constructed with two resistors that know the resistance and size of the 

voltage distribution of between 0 and 5 volts between the resistance of the light 

senso .  

 

Figure 98

Figure 99

Figure 97
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the resistance value of the light sensor to be very small, allowing over-current to flow to the analog input 

pin, which can also be prevented.  

 

CAK Starter Code > 12_01_Photoresistor 

1 / *  This sketch measures the brightness of light using a light sensing sensor. 

2 
 *  A1 pin connected to the light sensing sensor enters an analog input value between 0 and 1023, depending 

on the brightness of the light. 

3  *  Analog input values are divided into 0 - 3 4 steps through map function and used for switch-case. 

4  */ 

5  

6 // Settings for LCD use 

7 #include <Wire.h>  

8 #include <LiquidCrystal_I2C.h> 

9 LiquidCrystal_I2C lcd(0x27,16,2);  // Set the LCD I2C address. Use 16 space 2 line LCD. 

10  

11 const int photoresistorPin=A1;  // connect the light sensor to the A1 pin 

12 const int sensorMin =0;      // Minimum sensor value found by experiment, can be modified. 

13 const int sensorMax =700;    // Maximum sensor value found by experiment, can be modified. 

14  

15 void setup() { 

16   lcd.init();                         // LCD initialization 

17   lcd.backlight();                // Turn on the backlight. (lcd.noBacklight() turns off the backlight.) 

18   lcd.setCursor(0,0);                 // first line first column 

19   lcd.print("Range : ");              // Message Output 

20    

21   Serial.begin(9600);            // Starts serial communication at 9600 speeds 

22 } 

23  

24 void loop() { 

25 // Read sensor values to map ranges 

26   int sensorReading = analogRead(photoresistorPin);   // Read the light sensor value from the A2 pin 

27   Serial.println(sensorReading);                                      

28   int range = map (sensorReading,sensorMin,sensorMax,0,3);  // Map the sensor values from 0 to 3. 

29   

30 // output messages according to sensor range 

31   switch(range) {                 // according to range 0-3 

32     case 0:                        // touch the sensor and when the sensor value is zero, 

33       Serial.println("DARK");             // Darkprint and replace lines in the serial window 

34       lcd.setCursor(9,0);                 // the ninth column of the first line 

35       lcd.print(range);                    // indicate brightness phase on LCD window 

36       lcd.setCursor(0,1);                 // the first column of the second line 

37       lcd.print("DARK");                // DARK Output 
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38       break; 

39        

40     case 1:                       // Put your hands close to the sensor and when the sensor value is 1, 

41       Serial.println("DIM");              // Dimprint and replace lines in serial window 

42       lcd.setCursor(9,0);                 // the ninth column of the first line 

43       lcd.print(range);                    // indicate brightness phase on LCD window 

44       lcd.setCursor(0,1);                 // the first column of the second line 

45       lcd.print("DIM");                 // DIM output 

46       break; 

47        

48     case 2:                       // Keep your hands away from the sensor and when the sensor value is 2 

49       Serial.println("MEDIUM");           // print medium on serial window and replace lines 

50       lcd.setCursor(9,0);                 // the ninth column of the first line 

51       lcd.print(range);                      // indicate brightness phase on LCD window 

52       lcd.setCursor(0,1);                 // the first column of the second line 

53       lcd.print("MEDIUM");                  // MEDIUM Output 

54       break; 

55        

56     case 3:                      // When the sensor value is 3 without touching the sensor nearby, 

57       Serial.println("BRIGHT");         // print the lightprint on the cereal window and replace the line 

58       lcd.setCursor(9,0);                 // the ninth column of the first line 

59       lcd.print(range);                      // indicate brightness phase on LCD window 

60       lcd.setCursor(0,1);                 // the first column of the second line 

61       lcd.print("BRIGHT");                   // BRIGHT Output 

62       break; 

63   } 

64   delay(50);                      // 50 millisecond delay to reliably read values 

65 } 

constrain(x, a, b); x to a specific range. 

x : number of restrictions, a : lower range, b : upper range, x, a, b are all data types 

Return x value if x is a value between a and b, return a value if x is less than a,  

Returns the b value if x is greater than b 

constrain(sensorValue, 0, 255);   

Returns 0 value if sensorValue value is less than 0; returns 255 if sensorValue 

value is greater than or equal to 255. 

Restrict the scope of 0 and 255. 

 

 

 

 

 

 

 

 

 



98 

 

 View Results 

 

Figure 100 

  

Figure 101 

When the program is uploaded, the light sensor detects the light and divides the amount of light into four 

stages to display the results in an LCD window. Touch the light sensor and observe the results as you keep 

away from it..   
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CAK Starter Code > 12_02_Photoresistor_Calibration 

1 / *  This sketch will learn how to calibrate the light sense sensor input values according to the surroundings. 

2 
 *  Read the value of the analog A1 pin to which the light sensor is connected for 5 seconds to store the maximum 

and maximum values. 

3  *  The maximum value stored is 0 and the maximum value is 255, which is converted through the map function. 

4  *  After uploading the code, cover the light sensor with your hands and press the reset button. 

5 
 *  Allow the maximum and maximum values to be stored while keeping hands away from the light sensor for 5 

seconds. 

6  *  Then, move your hands around the light sensor to check the change in the blue brightness of the RGB LED. 

7  */ 

8  

9 // set up for LCD use 

10 #include <Wire.h>  

11 #include <LiquidCrystal_I2C.h> 

12 LiquidCrystal_I2C lcd(0x27,16,2);  // set the LCD I2C address. 16 space 2 lines LCD use 

13 // Variable setting 

14 const int photoresistorPin=A1;  // Connect light sensor to A1 pin 

15 const int redLED=13;            // connect the calibration notification LED to pin 13. 

16 const int bluePin=11;           // connect LEDs for brightness display according to sensor value to number 11. 

17 int sensorValue =0;         // store the light sensor value 

18 int sensorMin =1023;        // set sensor max to 1023. 

19 int sensorMax =0;           // set the sensor maximum value to 0 

20  

21 void setup() { 

22   // Calibration Notification LED Output Settings 

23   pinMode(redLED, OUTPUT); 

24   digitalWrite(redLED, HIGH); 

25    

26   // LCD setting 

27   lcd.init(); 

28   lcd.backlight();                // turn on the backlight (lcd.noBacklight() turns off the backlight). 

29   lcd.clear(); 

30   lcd.setCursor(0,0);                 // First line first column 

31   lcd.print("Calibration");              // output messages 

32   lcd.setCursor(0,1);                 // First line first column 

33   lcd.print("START");              // output messages 

34    

35  // Sensor value compensation 

36   while(millis() < 5000) {                     // for 5 seconds 

37     sensorValue = analogRead(photoresistorPin);           // save sensor values 

38     if(sensorValue > sensorMax) {                  // sensor value is greater than maximum 

39       sensorMax = sensorValue;                           // reset to maximum value 

40     } 

41  

42     if(sensorValue < sensorMin) {                  // sensor value is less than the maximum value 

43       sensorMin = sensorValue;                           // reset to maximum value 

44     } 


